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 تمهيد 01
Preface



توحيد الدعم والحب 
للأخضــر تحـت رايــة 

وحملة واحدة..

P تمهيد تمهيد
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 الحملة الوطنية
National Campaign

انطلاقًا من دعمنا للمنتخب السعودي لكرة القدم في 
دولة  في  سيقام  والــذي  بالمونديال  السادسة  مشاركته 
قطر هذا العام 2022، ندعوكم للمشاركة بحملة قدام 

لدعم اللاعبين معنوياً.

In support to the Saudi national football team 
in Qatar Mondial 2022, we invite you all to 
participate in this unified national campaign.
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 لماذا هذا الدليل؟
Why this guideline?

الحملة  لهوية  ليكون مرجعا شاملا  الدليل  صمم هذا 
الـــعـــام في المظهر  الــتــنــاســق  لــيــحــقــق  ــك  ــ “قــــــدّام” وذل

والهوية البصرية.

ــعــنــاصر  ــذا الـــدلـــيـــل عــلــى الإرشــــــــادات وال ــحــتــوي هــ ي
الصحيحة  البصرية  اللغة  لتكوين  اللازمة  التصميمية  
والوصف التفصيلي لاستخدامها وبنائها. الالتزام بهذه 
الإرشادات سيحقق الأثر المطلوب من الحملة وتناسق 

هويتها في جميع تطبيقاتها داخل المملكة وخارجها.

This guideline were designed to act as 
the main reference for the campaign 
identity to ensure the correct and cohesive 
identity application.

It contains descriptive and detailed guideline 
as well as all design elements necessary 
to build the correct application. You're 
adherence to this guideline will maximize 
the impact out of this campaign.
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قيم المشجع 
 السعودي

 Fans Values
والحب  الدعم  توحيد  في  الحملة  هــذه  أهمية  تكمن 
هذه  استلهمت   . واحـــدة  وحملة  ــة  راي تحت  للأخضر 
التي  السعودي  المشجع  وقيم  شخصية  مــن  الحملة 

يمتاز بها دون المشجعين حول العالم. 

The importance of this campaign lies in 
uniting support and love for our national 
football team under one banner and 
campaign. This campaign was inspired by 
the personality and values ​​of Saudi Fans 
that distinguishes them from all world fans.

الحماس 
Enthusiasm

الإصرار
Determination

التحدي
Challenge

التفاؤل
Optimism

التعاون
Collaboration

الاحترام
Respect
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 كلمة واحدة ..
 من ثقافتنا كلنّا .. 

 يقولها الكبير والصغير .. 
تختزل كل معاني الدعم 
والتحفيز والعزم والإرادة 

والرؤية والطموح والتفاؤل

One word inspired from our 
culture and spirit. it unites us all.
One word used by the young 
and the old. It combines the 
meanings  of support, motivation, 
determination, vision ambition 
and optimism.

 لماذا قدّام؟
Why Giddam?



 الشعار ٠٢
The Logo



T ار عالشالشعار

9 Back to contents page الرجوع لصفحة المحتويات

 شعار قدّام
Giddam Logo

المشجع  شخصية  ليعكس  ــدّام  قــ شــعــار  تصميم  تــم 
والقوة  والــحــمــاس،  بالطاقة  تتسم  والــي  السعودي 
قدّام  شعار  يتميز  الرياضية.  والــروح  والتفاؤل  والثقة، 
من  للعديد  ومناسبته  العالية  والمــقــروئــيــة  بــالــوضــوح 

الاستخدامات والتطبيقات.

Giddam logo design was inspired by the 
Saudi Fan personality traits, energetic, 
enthusiastic, confident and optimistic.
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المساحة الآمنة 
 حول الشعار

Clear Space
ــنـــة حــــول الــشــعــار  ــاء عــلــى مــســاحــة آمـ ــ ــق ــ يــجــب الإب
دون  ــة  ــ ــحـ ــ ــواضـ ــ الـ مـــقـــروئـــيـــتـــه  ــــى  ــل عــ ــافــــظ  ــحــ ــ ي كي 
ــارات الأخــــــرى. ــعــ ــشــ ــ ال ــاصر أو  ــنـ ــعـ الـ ــع   الـــتـــداخـــل مــ

( الموجودة في  تقاس هذه المساحة باستخدام الشدّة )
الشعار كما هو موضح في الشكل المقابل.

Clear space around the logo should remain 
free of other elements or other logos to 
preserve its legibility. 

This clear space can be measured by using 
the width of the shadda symbol ( ) from the 
arabic logotype.
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 تموضع الشعار
Logo Placement

العام  التناسق  على  الشعار  تموضع  تحديد  يساعد 
للهوية وسهولة تطبيقها ينصح باستخدام الشعار فقط 

في الأماكن الموضحة في الشكل المقابل.

Logo placement can ensure the  
overall consistency of the identity. It is 
recommended to use the logo only in the 
places shown in the figure.

 التموضع الصحيح
Correct Placement

 التموضع الخاطئ
Incorrect Placement
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 النسخ اللونية للشعار
Logo Color Versions

النسخة   )1( لــونــيــتــن،  بنسختين  ــدّام  ــ ق شــعــار  يـــأتي 
الأســاســيــة بــالــلــون الأخـــر الــغــامــق لــاســتــخــدام على 
الخلفيات والصور الفاتحة. )2( النسخة البيضاء والتي 
سيتم  كما  الداكنة  والــصــور  الخلفيات  على  تستخدم 

توضيحه في الصفحة التالية من هذا الدليل.

The Giddam logo comes in two color versions, 
(1) the dark version to be used over light 
backgrounds and images. (2) The white 
version to be used over dark backgrounds 
and images as explained on the next page 
of this guide.
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 استخدام الشعار
Logo Usage

يساعد الحفاظ على التلوين الصحيح للشعار في الحفاظ 
المقابل  المخطط  يوضح  الهوية ووضوحها.  تناسق  على 

التلوين الصحيح للشعار على الخلفيات المختلفة.

The correct logo coloring will help to ensure 
the consistency and clarity of the identity. The 
following matrix shows the correct coloring 
of the logo over different backgrounds.

خلفية بيضاء
Light background

صورة داكنة
Dark photo

خلفية بلون أخضر داكن
Dark green background

صورة فاتحة
Light photo

فوق عناصر التصميم
Over design elements

صورة ليس فيها تضاد كاف مع الشعار
A photo with not enough contrast
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 الاستخدام الخاطئ
Logo Misuse

يرجى  الحقيقية،  وأوزانــه  وألوانه  الشعار  على  للحفاظ 
عدم التغيير في ملامح الشعار أو ألوانه. الأشكال المقابلة 

توضح بعض الأمثلة للاستخدامات الخاطئة للشعار.

To preserve the look and feel of the identity, 
please do not alter the logo, its colors. The 
corresponding figures show some examples 
of misuses of the logo.

Logo

شد أو ضغط الشعار
Stretch or compress the logo

تغيير تركيب الشعار
Changing logo lockup

إضافة تأثير على الشعار
Adding effects to the logo

إضافة إطار أو ظل للشعار
 Adding shadow or outline to

the logo

 عدم الحفاظ على المساحة الآمنة
Not preserving a clear space

تغيير الخط المستخدم في الشعار
Changing logotype

تغيير لون الشعار
Changing logo colors

حذف جزء من الشعار )الشدة(
Removing any part of the logo

عدم وجود تباين كافٍ بين 
الخلفية والشعار

 No engouh contrast with
the background
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 الشراكات
Co-branding

لاستخدام  المناسبة  الأساليب  المقابل  الشكل  يوضح 
شعار قدّام مع شعار أو شعارات لعلامات أخرى )يرجى 

مراعاة المساحة الآمنة حول الشعار(.

The corresponding figures show the correct 
way of using Giddam logo along with 
other logos.

LogoLogo

LogoLogo

Logo

LogoLogo

1

2
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محظورات يجب 
 تجنبها

To be avoided
الفيفا  الــتــالــيــة وفـــق قـــوانـــن  تــمــنــع الاســـتـــخـــدامـــات 

وهي كالتالي:

Any use of the FIFA IP is prohibited, including 
but not limited to:

مجسم كأس العالم
The FIFA World Cup Trophy

العلامة الرئيسية
The FIFA Corporate Logo

الشعار الرسمي
The Official Emblem

إحساس وانطباع الهوية الرسمية
The Official Look

التميمة الرسمية
The Official Mascot

اسم التميمة الرسمية
The Official Mascot name
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محظورات يجب 
 تجنبها

To be avoided
تــمــنــع الاســتــخــدامــات الــتــالــيــة وفـــق قــوانــن الاتــحــاد 

السعودي لكرة القدم وهي كالتالي:

The following uses are prohibited, 
according to thw laws of Saudi Arabian 
Football Federation:

شعار الاتحاد السعودي لكرة القدم
Saudi Arabian Football Federation logo

صور اللاعبين
Players Photos

شعار المنتخب السعودي
Saudi National Team logo



٠٣
 اللغة البصرية 

Visual Language
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 الألوان
Colors

ــدّام هـــي مــكــونــات أســاســيــة تــضــيــف قيمة  ــ ــوان قـ ــ ألـ
بــريــة لــلــعــامــة وشــخــصــيــتــهــا ويــجــب اســتــخــدامــهــا 
جميع  في  الاتــســاق  على  للحفاظ  الصحيح  بالشكل 

تطبيقات العلامة.

Giddam colors are essential components 
of the brand identity that add visual value 
and presonality to it and must be used 
correctly to maintain consistency in all 
brand applications.

Pantone 7722 C
CMYK 93-41-55-44
RGB 0-79-81
HEX #004F51

Pantone Green C
CMYK 100-0-60-0
RGB 0-168-135
HEX #00A887

Pantone 331 CP
CMYK 27-0-15-0
RGB 198-228-225
HEX #C6E4E1

CMYK 0-0-0-0
RGB 255-255-255
HEX #ffffff
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 خط قدّام للعناوين
 Giddam Display

Typeface
تم تصميم خط "قدّام" من وحي الشعار ليتكاملا معاً 

في إيصال طابع مميز وخاص بالعلامة. 

هـــو خـــط مـــن وزن واحـــــد يــشــمــل جــمــيــع المـــحـــارف 
العربية  الأرقـــام  وكذلك  الأساسية  واللاتينية  العربية 

وعلامات الترقيم. 

بشكل  الرئيسية  العناوين  في  "قـــدّام"  خط  يستخدم 
الشعار  بمعية  الــخــط  اســتــخــدام  بــالإمــكــان  ــاسي.  أســ
ــعــروضــة في  لــصــنــع شـــعـــارات نــصــيــة مــســانــدة مــثــل الم

الصفحة التالية.

The “Giddam” font was inspired by the logo 
to convey a distinctive and special character 
for the brand.

It is a single weight font that includes all 
basic Arabic and Latin characters as well 
as Arabic numbers and punctuation marks.

The Giddam font should be mainly used in 
headlines. The font can be used with the 
logo to make supporting logotypes as shown 
in the next page.

Saudi National Team 
Support Campaign
٢٠٢٢.. Lets Go!

د ذ   أ ب ببب ت تتت ثثث ج  ججج ح ححح خ خخخ د  ـ
ز  ش ششش  س سسس ص صصص ض  ر ز ـ ـذ ر ـ

ضضض ط ططط ظ ظظظ ع ععع غ غغغ ف ففف ق 
و ي ييى  ققق ك ككك ل للل م ممم ه ههه و ـ

ABCDEFGHIJKLMNOPQRSTU
VWXYZabcdefghijklmnopqrs
tuvwxyz

٠١٢٣٤٥٦٧٨٩

خط عناوين عربي }تيني لحملة 
دعم المنتخب السعودي 

بالمونديال ..
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 خط قدّام للعناوين
 Giddam Display

Typeface
يحتوي خط "قدّام" على رمزيات صقر قدّام وعدد من 
خلال  من  استخدامها  يمكن  التي  المساعدة  الأيقونات 

برامج التصميم كالتالي:

Illustrator & Indesign: Type > Glyphs
 Photoshop: Type > Panels > Glyphs panel

 

The “Giddam” font contains different 
symbols found in (Giddam Falcon) and some 
icons. It can be used as follows:

Illustrator & Indesign: Type > Glyphs
 Photoshop: Type > Panels > Glyphs panel

 

ꀄꀅꀆꀙꀡꀒꀴꀓꀔ
ꀤꀥꀩꀨꀸꀶꀹꀑ

السعوديةꀸا�رجنتين

ꀔقووول

كأس العالم قطر ٢٠٢٢  
٢٢ نوفمبر ٢٠٢٢ 

١٠:٠٠ مساءً 
استاد لوسيل 

ꀵ
ꀈ
ꀱ
ꀠ
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 خط قدّام للعناوين
 Giddam Display

Typeface
أيقونة من خلال  المباراة على شكل  نتيجة  كتابة  يمكن 
تحديد  يــق  طــر عــن  وذلـــك   Stylistic Sets خاصية 

النص ثم:

 Illustrator: Window > Type > OpenType >
 Sylistic Sets > Score

The “Giddam” font contains iconic score 
numbers by using Stylistic Sets features 
as follows:

 Illustrator: Window > Type > OpenType >
 Sylistic Sets > Score

نتيجة المباراة 

١:٢

نتيجة المباراة
١:٢

نتيجة المباراة

١:٢

نتيجة المباراة
١:٢

)1(
 قم بتحديد النص

Sellect the text box

)2(
Score ثم اختر Stylistic Sets  اضغط على OpenType من قائمة
From OpenType panel sellect Stylistic Sets then Score
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 خط قدّام للعناوين
 Giddam Display

Typeface

خـط
قدّام

KSA
الجمهور

Lets Go!
منتخبنا

YEAH!السعودي
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 الخط الثانوي
 Secondary

Typeface

IBM Plex Sans Arabic
للنصوص  ثــانــوي  كخط   IBM Plex خــط  يستخدم 

الطويلة والكتابات التوضيحية.

The IBM Plex typeface is used as a secondary 
font for body copy.

IBM Plex Sans Arabic 
Regular

ABCDEFGHIJKLMNOPQR
abcdefghijklmnopqrstuvwx 
1234567890
 أبجد هوز حطي كلمن سعفص
قرشت ثخذ ضظغ

tem faccum qui dolo 
vent periberis del id 
quia iumquia spientia 
quisimus explit omnis 
minit offici blautas sum 
sunt. Faccupti omnihiciis 
non coristotatum 
dolupti cone et as que 
od exceped itatenimi, 
cumquia spellab 
id quas volestetu. 
Faccupti omnihiciis non 
coristotatum.

هذا النص هو مثال لنص يمكن 
أن يستبدل في نفس المساحة، 

لقد تم توليد هذا النص من 
مولد النص العربى، حيث 

يمكنك أن تولد مثل هذا النص 
أو العديد من النصوص الأخرى 
يادة عدد الحروف  إضافة إلى ز

التى يولدها التطبيق.
كبر  إذا كنت تحتاج إلى عدد أ

من الفقرات يتيح لك مولد 
يادة عدد الفقرات  النص العربى ز
كما تريد، النص لن يبدو مقسما 

ولا يحوي أخطاء لغوية.

IBM Plex Sans Arabic  
Bold

ABCDEFGHIJKLMNOPQR
abcdefghijklmnopqrstuvwx 
1234567890
 أبجد هوز حطي كلمن سعفص
قرشت ثخذ ضظغ
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من  قـــدّام(  )صقر  الأســاسي  التصميم  عنصر  استلهم 
قطر  لمــونــديــال  الــســعــودي  المنتخب  قميص  تصميم 
والتحدي  والــقــوة  الــركــز  روح  الصقر  يمثل   .2022
الـــراث  تنقل  مــتــنــوعــة  يـــات  رمـــز مــعــه  يحمل  وكــذلــك 

والثقافة السعودية للعالم. 

The main design element (Giddam Falcon) 
was inspired by the Saudi National Team 
jersey. The falcon represent the focus, 
strength well and challenging spirit. the 
falcon carries with it various symbols 
that convey Saudi heritage and culture to 
the world.

 صقر قدّام
Giddam Falcon

مستوحى من نقوش قميص المنتخب السعودي
Inspired by offical Saudi national team jersey



V اللغة البصرية اللغة البصرية

26 Back to contents page الرجوع لصفحة المحتويات

 صقر قدّام
Giddam Falcon

 رمزيات صقر قدّام
Giddam Falcon Symblos

في  الموجودة  المختلفة  الرمزيات  المقابل  الشكل  يوضح 
الرمزيات إلى قسمين أساسيين:  )صقر قدّام(. تقسم 

رمزيات سعودية ثقافية و رمزيات احتفالية تشجيعية.

The corresponding figure shows the different 
symbolisms found in (Giddam Falcon). The 
symbols are divided into two main parts: 
Saudi cultural symbols and celebratory 
encouraging symbols.

Palms

الحجرحي الطريفالروشانالسدو

الكورة .. 
حماس الكورة السعودية 

الصقر..
صقورنا الخضر

القلب .. 
حب الرياضة وحب
تبسيط لكأس العالمالمنتخب والوطنية 

ورد الطائفالقط العسيري 
SadoRoshanAl TuraifHegraAsiri Qatt Art

النخيل
 Ships
يتون الجوفالنوخذة جبل طويقالقهوة السعوديةز

Al Jouf OlivesSaudi CoffeeTuwaiq Mountain

FlagsSaudi FootballGreen FalconsFootball PassionWorld Cup Cheering chantsCheering drums

Taif Roses

البوق.. تشجيع
الأعلام.. 

انتماء وفخر 
طبول التشجيع

والأهازيج

رمزيات سعودية ثقافية

رمزيات احتفالية تشجيعية
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 استخدام صقر قدّام
 Usage of Giddam

Falcon

الاستخدام الصحيح
Correct Usage

الصحيحة  الاســتــخــدامــات  المــقــابــلــة  الأشــكــال  تــوضــح 
لصقر قدّام.

The corresponding figures show the correct 
usage of the Giddam Falcon.التلوين الصحيح لصقر قدّام

Correct Coloring of Giddam Falcon

 يمكن تكبير الصقر ليملأ المساحة كاملة
 It is possible to enlarge the falcon

to fill the whole background

يمكن التركيز على أحد العناصر وتكبيرها
 It is possible to enlarge one

element from Giddam Falcon

يمكن تكبير الصقر ليملأ جزءًا من المساحة
 It is possible to enlarge the falcon

to fill a part of the background
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 استخدام صقر قدّام
 Usage of Giddam

Falcon

الاستخدام الخاطئ
Incorrect Usage

الخاطئة  الاستخدامات  بعض  المقابلة  الأشكال  توضح 
لصقر قدّام.

The corresponding figures show some 
misuses of the Giddam Falcon.

 تلوين خاطئ لصقر قدّام
Incorrect coloring

استخدام خاطئ لصقر قدّام
Incorrect usage of Giddam Falcon

لا يمكن جعل زاوية الصقر للأسفل
The falcon cannot face downward

 تلوين خاطئ لصقر قدّام
Incorrect coloring

استخدام الصقر بمقاس صغير جدًا
Using the falcon in tiny scale

 تلوين خاطئ لصقر قدّام
Incorrect coloring
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 أسلوب الأيقونات
Iconography Style

الشعار  رســم  مــن  الأيــقــونــات  رســم  أســلــوب  استلهم 
جميع  بين  الاتــســاق  على  للحفاظ  التصميم  وعناصر 

تطبيقات الهوية.

The iconography style was inspired by 
the logo and design elements to maintain 
consistency across all identity applications.
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 تطبيق اللغة البصرية
 Visual Language

Implementation

Logo Placeholder

نوان نصي
ثال لع

م

تبداله
يمكن اس

الخلفية
Background Layer

عناصر التصميم
Design Elements

الصورة (اختياري)
Photo Layer (Optional)
يجب أن تكون بدون خلفية ويضاف لها ظل خفيف

Must be cut-out with a light shadow

الشعار
Logo Layer

يمكن استخدام الشعار أو أحد الشعارات النصية المساندة
 Contains Giddam logo or any of the supported

logotypes

يجب أن تكون بهذا اللون
Must be in this color

من الممكن أن تكون بأحد هذه الأساليب
Could be in one of these styles

التفاصيل ا�ضافية (اختياري)
Extra Details Layer (Optional)

يمكن أن تحتوي على العناوين والنصوص الإضافية والمعلومات، 
والشعارات الإضافية وغيرها من التفاصيل.

 This layers may include the headline and any extra
details like body copy, hashtags, info, and other logos
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 تطبيق اللغة البصرية
 Visual Language

Implementation

الصورة
Photo Layer

عناصر التصميم
Design Elements Layer

يجب أن تكون صورة ذات خلفية
Must be with a background

الشعار
Logo Layer

يمكن استخدام الشعار أو أحد الشعارات النصية المساندة
 Contains Giddam logo or any of the supported

logotypes

Logo Placeholder

نوان نصي
ثال لع

م

تبداله
يمكن اس

التفاصيل ا�ضافية (اختياري)
Extra Details Layer (Optional)

يمكن أن تحتوي على العناوين والنصوص الإضافية والمعلومات، 
والشعارات الإضافية وغيرها من التفاصيل.

 This layers may include the headline and any extra
details like body copy, hashtags, info, and other logos
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 تطبيق اللغة البصرية
 Visual Language

Implementation

 Examples أمثلة
اللغة  لعناصر  الصحيحة  للاستخدامات  أمثلة  يلي  ما 
ــة مــجــتــمــعــة: الــخــطــوط، والألـــــــوان، وعــنــاصر  ــبــري ال

التصميم، والصور.

The corresponding figure shows some 
examples of correct uses of the visual 
language elements in combination: fonts, 
colours, design elements, and images.

Logo Placeholder

Logo PlaceholderLogo Placeholder

Logo Placeholder

Logo Placeholder

Logo Placeholder

#هاشتاق

Logo Placeholder

#هاشتاق

Logo Placeholder

مثال لعنوان
يمكن استبداله

Logo Placeholder

Logo Placeholder

مثال لعنوان
يمكن استبداله

هذا النص هو مثال لنص يمكن أن يستبدل في نفس المساحة، لقد تم 
توليد هذا النص من مولد النص العربى، حيث يمكنك أن تولد مثل هذا 

النص أو العديد من النصوص الأخرى.

#هاشتاق
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Logo Placeholder

#هاشتاق

Logo Placeholder

#هاشتاق

Logo Placeholder

#هاشتاق

Logo Placeholder

#هاشتاق

 تطبيق اللغة البصرية
 Visual Language

Implementation

 Examples أمثلة
اللغة  لعناصر  الصحيحة  للاستخدامات  أمثلة  يلي  ما 
ــة مــجــتــمــعــة: الــخــطــوط، والألـــــــوان، وعــنــاصر  ــبــري ال

التصميم، والصور.

The corresponding figure shows some 
examples of correct uses of the visual 
language elements in combination: fonts, 
colours, design elements, and images.
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Logo Placeholder

#هاشتاق

مثال لعنوان
يمكن استبداله

Logo Placeholder

#هاشتاق

مثال لعنوان
يمكن استبداله

هذا النص هو مثال لنص يمكن أن يستبدل في نفس المساحة، لقد تم توليد هذا النص من 
مولد النص العربى، حيث يمكنك أن تولد مثل هذا النص أو العديد من النصوص الأخرى.

#هاشتاق

مثال لعنوان
يمكن استبداله

هذا النص هو مثال لنص يمكن أن يستبدل 
في نفس المساحة، لقد تم توليد هذا النص من 
مولد النص العربى، حيث يمكنك أن تولد مثل 

هذا النص أو العديد من النصوص الأخرى.

Logo Placeholder

Logo Placeholder

#هاشتاق

 تطبيق اللغة البصرية
 Visual Language

Implementation

 Examples أمثلة
اللغة  لعناصر  الصحيحة  للاستخدامات  أمثلة  يلي  ما 
ــة مــجــتــمــعــة: الــخــطــوط، والألـــــــوان، وعــنــاصر  ــبــري ال

التصميم، والصور.

The corresponding figure shows some 
examples of correct uses of the visual 
language elements in combination: fonts, 
colours, design elements, and images.
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